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ADAPT-MAT is a computer program that enables you to model, analyze, design, and 

generate structural drawings for ground supported concrete structures that are used to 

transfer load to the underlain soil in a serviceable and safe manner. The program can 

handle practically all possible foundation configurations and loads, using a state-of-the-

art 3D modeling and Finite Element Technology, and designing in accordance with the 

US and major international building codes.   

 

Following a short glance at some of the features of the program that are described below, 

it is recommended that you go through the section on “Quick Start” to familiarize 

yourself with the operation of the program.  Also, it is recommended to follow the 

ADAPT-Builder 20 GUI Quick Reference Guide in conjunction with this manual for 

detailed descriptions of each ribbon, tool panel and tool associated with the latest version 

of the program. Next, follow the tutorial, before you start your design project.  

 

Since this program forms a part of the ADAPT-Builder suite, the general graphical 

interface and modeling techniques are described in the ADAPT-Modeler and ADAPT-

Floor Pro User Manuals. This User Manual forms part of the ADAPT-MAT software 

package. It is recommended that you keep the manual handy and refer to it when needed. 

 

If you are already familiar with ADAPT-Floor Pro, you may skip the section on Quick 

Start, and Modeling and Design Process, since the two programs use essentially the same 

interface, modeling and design process. 
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2.1 OVERVIEW 

This chapter explains the basic features of the program. 

2.2 GEOMETRY 

A foundation mat or raft as it is also referred to, can be faithfully modeled as it is 

intended for construction. The following describes the structural components that 

can be modeled and handled by the program as part of a foundation system; 

• Slab regions: a foundation mat can consist of one or more slab regions, 

each with its own shape on plan, and its own thickness.  The slab 

regions can have different elevations, creating steps either at the top or 

bottom of the foundation system. 

 

FIGURE 2.2-1 VIEW OF A MAT FOUNDATION CONSISTING OF MORE THAN ONE 

SLAB REGION WITH STEPS BOTH AT TOP AND BOTTOM 

 

• Grade beams: Grade beams can be in any number, any dimension and 

orientation. Grade beams can be standalone or be part of a foundation 

slab. If they are part of the foundations slab, their structural interaction 

with the slab in resisting the applied loads is automatically accounted 

for in the analysis and design steps of the software. Further, the 

program recognizes the elevation of the grade beams with respect to 

the foundation slab in both its analysis and design stages. 
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FIGURE 2.2-2 VIEW OF A FOUNDATION SLAB WITH INTEGRATED GRADE 

BEAMS 

 

 

FIGURE 2.2-3 PLAN OF A FOUNDATION SYSTEM WITH ISOLATED FOOTINGS 

AND GRADE BEAMS 
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FIGURE 2.2-4 VIEW OF A FOUNDATION SYSTEM WITH ISOLATED FOOTINGS, 

GRADE BEAMS AND FOOTINGS BELOW WALLS 

 

• Pile caps: Pile caps can be modeled either in isolation, or as part of a 

foundation mat. When integrated with the foundation mat, their 

interaction with the mat in resisting the applied load will be 

automatically accounted for by the program. 

• Thickening below slab: Thickenings below a mat slab to resist 

punching shear below columns can be readily modeled with a column-

drop/panel tool. The program accounts for the local stiffening of the 

foundation slab due to added thickness, as well as the resistance it 

provides for punching shear. 

• Openings: Openings of regular or irregular geometry can be defined in 

any number and at any location. 

• Elevator pits: Significant depressions in foundations slab with 

perimeter walls, typical of elevator pits can be modeled in the program 

and analyzed.  
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(a) elevator shaft model 

 

 

 

 

 
(b) pads below columns 

 
FIGURE 2.2-5 ELEVATOR SHAFTS AND PADS BELOW COLUMNS AND WALLS, 

AND ELEVATOR PITS CAN BE MODELED WITH CORRECT GEOMETRY AND 

ELEVATION 

 

• Walls and columns above foundation mats: One story height of walls 

and columns can be modeled above a foundation system. The program 

accounts for the stiffness of these structural components when 

analyzing the foundation. The degree of stiffness of each of these 

structural components depends on the fixity defined by you at the far 

end of a wall or a column. The default setting of the program is 

freedom to displace and rotate at the far ends of the walls and columns 

above a foundation. The height of a wall or column above a foundation 

is taken to be the story height defined by you, but you have the option 

to modify the height of each wall. 

• Upturned beams; Beams can be modeled to be entirely above a 

foundation slab, or partially above and partially below the slab. 
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FIGURE 2.1-6 VIEW OF A FOUNDATION SYSTEM INCLUDING THE MODELING 

OF WALLS AND COLUMNS 

2.3 SUPPORT CONDITIONS 

A foundation system can be supported partially or wholly, on a variety of support 

conditions as described below: 

2.3.1 Soil Support Area 

Foundations can be modeled to rest on more than one type of soil. Each 

soil type will be specified with its own property and the support area it 

covers.  A supporting soil region can be extended beyond the boundary of 

a mat and below the openings. The program will consider only the 

resistance of soil that is immediately below the structural members of the 

foundation. Soil regions modeled extending beyond the boundary of a 

mat’s structural members and within the openings will not be considered 

to provide support. Not all the regions of a foundation system need be 

supported on soil. You may define parts of the foundation to overhang or 

span unsupported lengths. 

The soil is represented by Winkler springs, for which you define the 

associated bulk modulus as part of your input data. The unit for the soil’s 

bulk modulus is lb/in3. This value typically varies between 100 to 400 pci 

(between 0.03 to 0.12 N/mm3). In the absence of detailed information 200 

psi (0.06 N/mm3) is a reasonable starting point.  
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2.3.2 Compression Only Soil 

You have the option to limit the transfer of force between a foundation 

member and its underlain soil as compression only.  This results in 

separation between the underlain soil and the foundation member, where 

tension is likely to occur – hence no-load transfer. Also, you can specify 

the soil to resist both tension and compression.  

The soil region you define provides only up and down support. For a 

support with capability of resisting forces in the horizontal direction and 

moments, you will use other options of support, as detailed below. 

2.3.3 Soil / Rock Anchors 

Soil and Rock anchors are designed to resist tensile forces only. They are 

used where there is potential of uplift, such as overturning due to high 

winds, seismic forces, or uplift from raised water table.  Under normal 

conditions, support is provided by soil, but when the load on a foundation 

results in uplift, the soil/rock anchors will be mobilized to resist the uplift. 

The tensile force developed in a soil/rock anchor depends on the user 

defined stiffness. In principle, soil anchors are “tension only” point 

supports with specified stiffness values. You will use point springs to 

model soil anchors. 

The default setting of the program is that the soil anchors take only tension 

in the vertical direction. You define their property in terms of (pounds per 

inch of extension, kN/mm extension, or tons/cm of extension).  The 

program provides you the option to specify stiffness for displacements 

other than vertical direction.  

2.3.4 Grade Beam Support 

Grade beams that are integrated with a mat slab do not need additional 

support definition. The soil region that supports the mat will also support 

the grade beam.  But for grade beams that are isolated (Fig. 2.3-1) you 

need to specify a line support along the beams. The stiffness of the support 

is defined in terms of displacement of the soil support per unit force 

placed on unit length of the grade beam [lb/in2; kN/mm2; t/m2). 

Obviously, the wider the grade beam, the stronger will be the resistance of 

the supporting soil, since the larger contact area mobilizes a larger volume 

of soil beneath the beam. 

 



 BASIC FEATURES Chapter 2 

 

13 

 

FIGURE 2.3-1 STANDALONE AND INTEGRATED GRADE BEAMS  

For example if the bulk modulus of the soil is 200 lb/in3, (0.06 N/mm3 

units) and the width of the grade beam is 24 inch (600 mm), the resistance 

of the soil per unit length of the beam to be specified is : 200x24 = 4,800 

lb/in2 length of grade beam (0.06x600 =  36 N/mm2 length).  

In the general case, you will use line spring tool with compression 

stiffness in the vertical direction to model grade beam supports. 

2.3.5 Line Springs 

Line springs provide you with a more general support condition than the 

simple support of a member on soil. The support provided by a line spring 

can be resistance along one or more of the three principal directions, with 

or without associated rotational stiffness. The stiffness provided along the 
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length of a line spring is constant. Changes of stiffness along a line are 

defined by several line springs, each with its own stiffness. 

2.3.6 Point Springs 

These can provide translational or rotational restraints at one or more 

directions, at one or more locations of your choice on the foundation 

system.  You identify the location of a point spring and specify its stiffness 

along and about the three principal directions as part of your input data.   

2.3.7 Point Supports 

You can define a point support anywhere at a foundation system and 

specify the type of fixity the selected location provides at the selected 

location. The fixity can be translation along one or more of the principal 

axes, and/or rotation about each. In addition to location on plan, you 

define the location of the point support in the vertical direction. 

2.3.8 Line Supports 

A line support is a more general form of a support condition in which the 

underlain soil can generally provide for a grade beam.  You start by 

defining the location and length of a line support. Then you specify the 

type of support that you want the line to provide. This is carried out by 

assigning restraints to the line support you have defined. The restraints can 

be translation along one or more principal direction(s), and/or rotation 

about one or more of the principal direction(s). The vertical location of the 

line support can be below, above or any other height with respect of the 

mat foundation.  

2.3.9 Piles  

Piles are used where the soil is considered inadequate in providing the 

support needed for the superstructure.  A pile-supported mat behaves 

essentially the same as a column supported slab, since the mat and its load 

are supported at discrete pile locations similar to a suspended slab 

supported on columns. There is no design contribution of the soil below 

the mat in providing resistance and is disregarded. Pile-supported mats can 

be best modeled and designed using ADAPT-Floor Pro. When using 

ADAPT-MAT each pile has to be modeled as a point spring having the 

same stiffness properties as the pile it represents. 
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2.3.10 Voids in Soil 

Where there is no soil support below part of a foundation, such as a 

foundation overhang of a light building along its perimeter due to loss of 

moisture in soil, you do not define a soil support.  Transfer of force 

between a foundation and soil can take place only at the locations where 

you define soil.  

2.4 MATERIAL PROPERTIES 

Each of the structural components specified, such as slab regions, grade beams, 

and reinforcement have can be specified with its own material property. Structural 

components of the same type, such as two columns can each have their own 

different material properties. You define the properties of the materials to be used 

in your model in the “Materials” pull-down menu and assign them to the 

structural components you create.  

2.5 LOADS 

The complete library and options for definition of loads located in ADAPT-

Modeler applies to ADAPT-Floor Pro and ADAPT-MAT.  Among many options, 

you can define point loads, line loads and patch loads (distributed load over a 

defined area) anywhere on the foundation slab. The loads you define can consist 

of concentrated forces along each of the principal directions and moments applied 

about each of the principal directions. 

2.5.1 Load Cases 

Each load you define is assigned to a “load case.”  This will enable you to 

group the loads that are associated with a common source. There is 

essentially no limitation on the number of loads that you may define, nor 

is there a limitation on the number of load cases. The program comes with 

default load cases of DEAD, LIVE, and PRESTRESSING (when 

ADAPT-MAT (PT) is used) along with several other pre-defined cases. 

The mat self-weight is automatically accounted for and by default, is 

included in load combinations for analysis.    

2.5.2 Load Combinations 

Depending on the building code you select, the program will automatically 

generate the primary load combinations of the code. The user has the 
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option to edit the default combinations and/or define additional load 

combinations. There is practically no limit on the number of load 

combinations you can define. In addition to reporting the outcome of each 

load combination, the program has the ability to determine and report the 

envelope of the analysis results of the load combinations you define. 

2.6 BASE REINFORCEMENT 

ADAPT-MAT allows the user to pre-define layers of reinforcement at any depth 

in the slab.  The reinforcement is referenced from the top or bottom of the slab 

and the user is prompted to enter the cover from the top or bottom reference 

plane.  This is known as “base reinforcement” in the program.  The reinforcement 

can be in one or two orthogonal directions that you define. The program considers 

base reinforcement in the analysis and design and reports the necessary 

reinforcement in addition to pre-defined base reinforcement. 

The base reinforcement you define, can be expressed in terms of (i)  bars at given 

spacing (regular mesh), or (ii) reinforcement areas per unit width of the slab, (iii) 

or isolated single or spaced bars with given length, size and location, (iv) or a 

combination of one or more of the above types.  Different regions of the mat can 

be assigned different reinforcement. In other words, you can define different mesh 

reinforcement specifications for different regions in the mat. 

2.7 POST-TENSIONING 

ADAPT-MAT features the entire capability of prestressing options that is 

available in ADAPT-Floor Pro. This includes full flexibility in defining tendon 

layout, post-tensioning type (un-bonded or bonded), and stressing operations.  

The ADAPT-Floor Pro 20 Basic Manual, Chapter 5 contains a detailed 

description of tendon modeling in the ADAPT-Builder platform.     

2.8 ANALYSIS 

Unlike the standard conditions of suspended slabs, the analysis of a mat 

foundation can be an iterative process. Where there is likelihood of separation of 

soil from the foundation mat, an iterative solution is required, in order to 

determine the location and extent of soil/foundation separation.   

The analysis process is initiated by assuming full contact of a mat with underlain 

soil. During each iteration, the program eliminates the regions of the soil/mat 

contact where uplift occurs, until full equilibrium of the entire structural system 
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through transfer of compressive force between the mat and its underlain soil is 

achieved.  During each iteration, the program re-generates the stiffness matrix of 

the structure, and obtains a solution. For this reason, and the fact that in such 

conditions superposition of load cases does not apply, the analysis of mat 

foundations with potential of uplift takes longer to achieve. 

To reiterate, difference between the analysis of a mat foundation and an elevated 

slab is that, where uplift occurs, the principle of superposition of solutions does 

not apply, since each solution with uplift relates to a different structural boundary 

condition of the structure.  

Like ADAPT-Floor Pro, the outcome of the analysis is in the form of 

displacements, forces and moments. When post-tensioning is present in a model, 

the program will report stresses at the top and bottom fibers of the mat.  ADAPT-

MAT (both RC and PT versions) generate and report the distribution of soil 

pressure below the mat and grade beams. 

 

FIGURE 2.8-1 EXAMPLE OF THE DISTRIBUTION OF SOIL PRESSURE BELOW A 

MAT WITH FULL SOIL/MAT INTERFACE CONTACT 
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(a) deflected shape 

 

(b) soil pressure 

FIGURE 2.8-2 DISTRIBUTION OF SOIL PRESSURE  

The example above shows, (a) the displacement of a foundation mat under a 

central concentrated load and overturning moments on the walls, and (b) the uplift 

(soil/foundation separation) at the tip of the walls due to the distribution of soil 

pressure. 

2.9 DESIGN 

ADAPT-MAT carries out a design of the mat slab by performing code checks 

prescriptive of the selected building code.  Where required, the program 

determines and reports reinforcement from the library of bar reinforcement as 

defined by the user or bar sizes of your choice. The program checks both service 

(SLS) and strength (ULS) requirements of the selected building code. The 

reinforcement report of the program includes the quantity, position, and length of 

each bar in plan, ready to be used in a structural drawing. Where post-tensioning 

is present, the program provides a detailed stress check as required prescriptive of 

the selected building code.  The stress checks can be reported both graphically 

and in tabular format.   

2.10 GENERATION OF DRAWINGS 

The reinforcement plan generated automatically by the program can be readily 

exported to either a DXF or DWG file format that can be used to combine with 

the remainder of your work in a construction drawing. 
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2.11 LINK WITH 3RD PARTY PROGRAMS AND ADAPT DATA EXCHANGE 

If the foundation slab you design forms part of a multi-story building for which 

you have developed an independent model in a commercially available program, 

and you have the results of the loads from the superstructure, there are several 

ways to facilitate the transfer of this information to ADAPT -MAT as applied 

load.  

• The common method is to simply enter the load in the program using 

the loading toolbar.  This is referred to commonly as the “manual” 

method of input. 

• Loads from other software can be formatted into the program’s data 

exchange file and be imported to ADAPT-MAT.  The program can 

read and import loads if the information is formatted according to 

ADAPT’s Data Exchange File.  

• ADAPT-MAT has the capability of importing solutions directly from 

other commercially available programs through use of the ADAPT-

Integration Console (IC).  Through creation of input/output files, this 

program creates a new ADAPT Data Exchange File that is imported to 

ADAPT-MAT.  In its current form, ADAPT-IC can import applied 

gravity and lateral loads and reactions.  As is often the case with mat 

foundations, the entire gravity load on a structure would be considered 

in mat design along with lateral loads.  There are current alternate 

methods that can be used in a third-party program which will allow the 

total gravity load to be imported to ADAPT-MAT.  It is recommended 

to consult with an ADAPT Technical Support Specialist for addition 

information.  support@adaptsoft.com   

 

mailto:support@adaptsoft.com
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3.1 OVERVIEW 

This chapter includes a simple example as an introduction to the program. Once 

you have reviewed the example in this chapter, it is recommended to review 

Chapter 6, “Tutorial” for a step-by-step description of data generation and 

design. 

3.2 OPENING THE PROGRAM 

• Open the program to display the splash window shown below. Select 

“MAT” option, if not already selected. Click OK to open the main 

program interface. 

 

• A thorough description of the main graphical user interface (GUI) and 

its menus and tools can be found in the ADAPT-Modeler & ADAPT-

Floor Pro 20 Basic Manuals. You may refer to them, if needed.  This 

section describes the features that are unique to the ADAPT-MAT 

program.   

• Getting started, a description of commonly used tools enabling the 

creation of a model are described below: 
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• Create a grid providing a unique set of dimensions and guide us to 

create the structure 

• Tools to build the mat, such as its geometry and other components 

• Tools to view the geometry in three dimensions and facilitate 

verification of modeling accuracy 

• Tools to define the soil spring support below the mat 

• Tools to apply loads on the mat 

• Tools enabling the user to mesh and analyze the mat 

• Tools used to view analysis results 

We will introduce and invoke each of the tools listed above one after the other in 

form of a quick start step-by-step guide.   

3.3 QUICK START – STEP-BY-STEP  

The purpose of this example is to show a step-by-step procedure to begin using 

ADAPT-MAT in the modeling of a mat foundation. 

3.3.1 Create a Grid 

In the Snap tools from the lower Quick Access Bar, select the icon, Grid 

Settings  and set the X and Y grid spacing to the desired dimension. 
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3.3.2 Building the Model 

Use Model→Add Structural Components to insert structural components 

such as slab regions, columns, walls, beams, openings, drop caps/panels, 

base reinforcement or to set the vertical plane dimensions (story heights).   

 

If the model is started with an import of a .dwg or .dxf file (see Section 

3.2.1) you can use the Transform panel, to transform closed polygons to 

structural components.  

 

Once a structural component is added, double-click on the any component 

to modify the default dimension(s) of the component.  After changes are 

made to the component properties, make sure to select the green 

checkmark for the changes to be updated and active.   

 



Chapter 3 QUICK START  

26 

3.3.3 Viewing the Model 

Once a model has been successfully built, where all necessary components 

are added, it is important to validate the accuracy of the model.  Doing so 

will ensure that the model most closely represents the foundation system 

being analyzed.  To make a cursory view of the model in two or three-

dimensions, use Home→Camera/Zoom. The tools located here allow you 

to view the model from different elevation and plan views.  You can also 

elect to view the structure as an isometric view.  This is useful when 

verifying more complex geometries and loading.  The toolbar contains 

several selections allowing you to pan, zoom, rotate, and refresh the view.   

 

The Visibility ribbon gives options to customize the display and what 

components and loads are shown in the main interface.  One of the most 

commonly used tools is the View Display tool   When this button is 

activated, a menu of items will be shown prompting the user to set those 

components and loads to be viewed along with the option to display 

component or load ID’s, Dimensions (load magnitude or moments), 

Labels or Symbols.  The symbol size and font height of text can also be 

modified.  
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3.3.4 Defining the Soil Support 

Soil supports defined as point, line or area springs can be added to the 

model from the Model→Supports or Springs. 

 

 Once the supports have been added to a model, as is the case with 

components, the user can double-click on the support to open the support 

properties.  In this dialogue window, the soil stiffness can be changed 

from the default setting.  Note also that line and/or point supports with 

assumed infinite stiffness can be included in a mat foundation model.  

These tools are located on the same toolbar.   

3.3.5 Application of Loads 

When a design code is selected from the Criteria→Design 

Criteria→Design Code , the program will automatically generate 

multiple Strength and Service load combinations.  Each combination is 

composed of default load cases defined as Live, Dead or PT (when post-

tensioning is included in a model).  See Section 2.4 for additional 

information related to load case and load combination generation. 

The Loading→General panel contains several tools used for the creation 

of point; line and area (patch) loads.  Any type of load can be added for 

any defined load case.  Note that the user can add as many load cases as 

desired in addition to those default cases created by the program.  The 

Patch and Line Load Wizard tools allow the user to easily create loads for 

a selected region or slab boundary.   

 

Once a load has been generated, the magnitude or moment values 

associated with the load type can be changed by double-clicking on the 

loading symbol and changing the value in the load properties window.  
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The group assignment and load case can also be modified using the load 

properties windows.  To select a load to modify, it is helpful to view the 

model in an isometric (top-front-right) view  from 

Visibility→Camera/Zoom. 

 

To view loads, the Loading ribbon contains the tool from Visibility→Show 

Loads   which will toggle load display in the main interface.  The View 

Load Settings tool   contains a rooted menu allowing the user to isolate 

the display of both load cases and load types.   

 



 QUICK START Chapter 3 

 

29 

3.3.6 Mesh and Analyze 

Once the model has been built with components, supports and loads, the 

model can be meshed and analyzed for a solution.  To mesh the structure 

use Analyze→Meshing→Mesh Generation .  A dialogue window will 

appear prompting the user to select a mesh and node consolidation 

dimension.  The default values are set to 3 ft and 1.5 ft.  The recommend 

mesh size is typically between 3-4 times slab thickness and the 

recommend node consolidation dimension is between 2-3 times slab 

thicknesses.  After meshing the structure, the model can by analyzed by 

selecting the Execute Analysis  tool.  

3.3.7 Viewing Analysis Results 

After the general model analysis has been completed, the analysis results 

can be viewed graphically and in report format.  For a cursory review of 

results after the first analysis, it is recommended to view the results 

graphically.  Go to Analysis→Analysis→Result Display Settings. A 

docked side window will appear, and graphical viewing selections can be 

made.   
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The program also includes a legacy graphical results viewer called 

ADViewer that can be opened in a separate window by selecting View 

Results from Analysis→Analysis .  The image below shows the 

derfault, ADViewer window.   
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At the left-hand edge of the ADViewer module, the user can select the 

Result type (e.g. Deformations, Slab Actions, Soil Pressure, etc.) along 

with the load combination for which the results type is to be viewed.  The 

individual structural and analysis components and component groups can 

be displayed from the same menu.   

A thorough description of the tools located in ADViewer can be found in 

Chapter 9 of the ADAPT-Floor Pro 20 Basic Manual.  These tools are 

equally applicable to ADAPT-MAT as well as ADAPT-Floor Pro and are 

universal to the ADAPT-Builder Platform.   
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4.1 OVERVIEW OF ADAPT-BUILDER PLATFORM 

Developed from the ground up with ADAPT Building Information Modeling 

(BIM) Technology, the ADAPT-Builder Platform is a collection of fully 

integrated design and analysis tools for concrete floor systems, foundations, and 

beam structures, whether with or without post-tensioning.  

With the ADAPT-Edge module, ADAPT-Builder allows for the analysis of 

gravity and lateral loads on an entire concrete building structure from roof to 

foundation, including automated load takedown. ADAPT-Edge can be used as a 

stand-alone product or together with ADAPT's specialized design software for 

floor and foundation systems – Floor Pro and MAT. In this way, Edge helps to 

simplify the analysis and design process by using only one model for floor, 

foundation, and building analysis and design. ADAPT-Edge is specifically 

designed for the rapid modeling of concrete structures and gives the option of 

adding prestressing or post-tensioning to any slab or beam member.  

ADAPT-Builder’s intuitive and easy-to-use 3D component modeling capabilities 

allow you to quickly model any structure. In addition, the Builder Platform is the 

industry's only solution that gives you the flexibility to analyze 3D structural 

models using either the Finite Element Method (FEM) or the Equivalent Frame 

Method (EFM). Specialized design tools for concrete beam frames, one-way or 

column-supported flat slabs, parking structures, mat foundations, ground-

supported slabs, column and wall design, as well as built-in building codes (e.g., 

American, Canadian, British, European, and Australian), ADAPT's Builder 

platform allows for a streamlined workflow.   
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FIGURE 4.1-1 ADAPT BUILDER MODULES 

4.2 ADAPT-BUILDER SPLASH SCREEN  

ADAPT-Builder is a general platform which contains ADAPT-MAT for the 

design of mat foundations. While opening the program, the user can choose the 

configuration as required in the project. ADAPT- Builder’s splash screen is 

shown in the Figure 4.2-1.  

Then user can select the Structure Type, and choose among the following: 

• Elevated Floor Systems, Beam Frames, Grid Frames (FLOOR PRO) 

• Mat/Raft Foundation, Grade Beams (MAT) 

• Post-Tensioned Slab-On-Ground (SOG) 

• Full building Gravity and Lateral Design (EDGE) 

Select ADAPT-MAT for the design and analysis of a mat foundation system. To 

design conventional reinforced concrete structure, select RC for mode.  To design 

a post-tensioned concrete structure, select PT/RC.  
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FIGURE 4.2-1 ADAPT BUILDER SPLASH SCREEN 

Finally, one needs to specify the System of units. SI, US or MKS can be selected 

in the program. Upon clicking on OK, it will open ADAPT-MAT environment.  

4.3 ADAPT-BUILDER GRAPHICAL USER INTERFACE 

Figure 4.3-1 shows the full-screen display of the ADAPT-Builder program, with 

typical features labeled for easy identification. 

 

FIGURE 4.3-1 ADAPT BUILDER MAIN SCREEN 
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ADAPT-Builder contains a ribbon-based user-interface that contain contextual, 

customizable tool panels. Each tool on a panel contains a tooltip when hovering over the 

tool icon that provides a brief description of the tool. Each panel can be expanded to 

show detailed information and descriptions for all tools on the panel. The Quick Access 

panels contain pre-defined and most-commonly used tools for easy access.  The top 

Quick Access panel is customizable and can contain user-defined tools. The bottom Quick 

Access panel contains fixed tools that are also available in most of the tool palettes 

belonging to a ribbon. At the top-right of the upper Quick Access panel is the set of Story 

Manager tools.  These tools allow the program active mode to be set for Single-Level or 

Multi-Level and also navigate vertically between levels.  The program ribbons include: 

 

• File – General save, print, import, export functions. 

• Home – UI and commonly used tools and settings. 

• Visibility – Tools related to graphical visibility options. 

• Modify – Tools related to modification of current components in the 

model. 

• Criteria – Material, analysis, and design criteria settings.  

• Model – Tools related to modeling of components and supports.  

• Loading – Tools related to all loading types, load takedown, LL 

reduction.  

• Tendon – Tools related to modeling, display, modification, and 

optimization of post-tensioning.   

• Rebar – Tools related to modeling, display, and modification of 

reinforcement.   

• Analysis – Tools related to meshing, vibration, cracking and general 

analysis.   

• Floor Design – Tools related to floor design strip generation, design or 

investigation, display, and results for floors.  

• PT/RC Export – Tools related to criteria and strip generation for 

export to ADAPT-PT/RC.  

• Column Design – Tools related to column groups, design parameters 

and column design and results.  

• Wall Design – Tools related to wall piers, wall sections, design 

parameters and wall design and results.  

• Reports – Tabular and graphical reporting.  

 

When the program is open through the splash screen shown in Figure 4.2-1, the program 

will auto-filter and show only those ribbons and tools applicable to the selected state of 

program module selections.  
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The Message/User Input Bar displays tool-specific information, program prompts, and 

any values that may be typed by the user for specific program procedures. The Status Bar 

displays such information as the mouse cursor coordinates (location), current unit system, 

current level, current drawing layer, and gridline spacing and status. A short description 

of each specific tool also appears in this area when the mouse cursor is placed over the 

corresponding tool button. 

4.3.1 Mouse Function and Operation 

The primary function of the mouse is through its left-click. Depending on 

the mode of the program, as outlined in the next section, the left-click will 

result in selecting the entity below the cursor, inserting an entity or 

performing an operation at the location of the cursor. 

The right-click of the mouse with cursor on the display portion of the 

screen will display the window shown in FIGURE 4.3-2 4.3-2.  Right-

click options are context specific and may change depending on the type 

of component selected while carrying out this operation. 

 

FIGURE 4.3-2 RIGHT-CLICK OPTIONS OF THE MOUSE 

Click on a menu item listed to perform the operation described.  Functions 

including layout of poly regions or polylines require the Close/End/Accept 

option to be selected.  Alternately, the user can select the ‘C’ key on the 

keyboard to close the operation.   If you right-click the mouse while the 

cursor is outside the Main Window, a list of all available toolbars appears. 

From this list, you can select the toolbars you want to display. 

Double-clicking on an entity opens its properties dialog box. 
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If more than one item exists in a location in the display screen, left click 

on the area, and use the Tab key on your keyboard to toggle between the 

multiple items in the same area.   

For dynamic rotation of the model view, use the SHIFT key + mouse 

scroller to control the rotation.   

4.3.2 Main User Interface 

For a complete description of the Graphical User Interface in ADAPT-

Builder please refer to the ADAPT-Builder 20 GUI Quick Reference 

Guide. The manual can be located by going to Help→Documentation in 

the ADAPT-Builder interface.   
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5.1 OVERVIEW 

This section outlines detailed steps to follow in designing a conventionally 

reinforced or post-tensioned mat foundation, using ADAPT-MAT. It is assumed 

that those steps pertaining to post-tensioning do not apply if the mat being 

designed is conventionally reinforced.  Depending on whether you already have 

an electronic file of the mat geometry or not and whether you are familiar with 

AutoCAD or not there are different options available to you. Refer to the flow 

chart and the text that follows for the details. 

5.2 DESIGN PROCEDURE 

The following steps are intended for completion of a full analysis and design of a 

mat foundation. The items listed here are discussed in greater detail in the 

ADAPT-Modeler 20 Manual.   

The suggested steps for the analysis and design of a mat foundation are: 

• Creation of the structural model 

• Define the soil support conditions 

• Validate the structural model by use of the tools for viewing analysis 

results 

• Complete and finalize input data 

• Perform analysis 

• Prepare  

• Design 

• Generate structural drawings 

• Generate structural calculation reports 

5.2.1 Create the Structural Model 

Use one of the following options to create your structural model 

o Import an AUTOCAD file of the model (DXF or DWG) and 

convert it to structural model by transformation.  
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o Define the foundation slab and loading, using the Build and 

Loading tools of the program.  This is also referred to as 

“manual” generation of a model.  

o Import geometry and load on the model from a multi-story 

analysis program, such as ETABS, or other programs 

supported by ADAPT-Builder platform.   

o Use the generic data exchange file format of the program to 

create and import the geometry of the foundation mat. 

The common and more accurate method for the generation of geometry of 

your structural model from the first option above, that is, importing an 

AUTOCAD file, since most of the commercially available multi-story 

software does not model the complex foundation geometry with adequate 

degree of accuracy. 

5.2.2 Define Soil Support Conditions 

Define the location and properties of the soil support, piles and rock 

anchors, if any. 

5.2.3 Validate the Structural Model 

In this step you determine whether the structural model of the foundation 

slab you have generated, and its support conditions are indeed a faithful 

representation of your requirements, before proceeding with detailed 

analysis and design. The steps are: 

o Mesh the structure  

o Analyze the structure for an arbitrary concentrated load in the 

central region of the mat and/or self-weight 

o View the deflected shape of the structure under self-weight and 

determine if the results look reasonable in shape and magnitude 

based on engineering experience and judgment.    

5.2.4 Complete and Finalize Input Data 

 

o Add post-tensioning tendons as required if the structure is post-

tensioned.  
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o Review and finalize the design criteria including material 

properties, analysis/design options, reinforcing bar selections 

and design code.   

o Specify reinforcement mesh to be included in your design, if 

any. 

o Define additional load cases or loads if necessary. 

o View the program-generated load combinations and edit if 

necessary.  

5.2.5 Perform Analysis 

 

o Analyze the structure 

5.2.6 Prepare to Design 

 

o Create support lines 

o Generate design sections automatically 

o Review the generated design strips. If necessary, modify the 

support lines and use splitters to refine the design strips 

created. Conclude your modifications with a re-creation of 

automatically generated design strips and sections.   

5.2.7 Validate the Code Compliance of the Design 

If the foundation system is not pre-stressed, the program automatically 

provides the adequate amount of reinforcement, where necessary, to meet 

the requirements of the design code you have selected for Strength and 

Serviceability.   

For pre-stressed foundations, in addition to the reinforcement 

requirements, the computed stresses must not exceed the code specified 

threshold. If this condition is not satisfied, the program shows the design 

sections with dashed lines in purple. At this stage, you must either modify 

the post-tensioning you have specified, or change other parameters of the 

foundation, such as thickness and redo the analysis and design. This 

process continues, until the solution is acceptable and code-specified stress 

limits are met.  To summarize: 
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o View the outcome of code check for design sections in X-

direction, followed by an examination of the same for design 

sections in Y-direction. 

o If there are no purple (dashed) lines the requirements of the 

building code you selected is satisfied.   

o If there are purple (dashed) lines, the code requirements have 

not been met; investigate and modify the slab until a solution is 

acceptable.   

o Execute the punching shear check – if applicable. 

o View the punching shear stress check on the screen, to 

ascertain that the calculated stresses do not exceed the 

maximum allowed by code. The program automatically reports 

these locations to you on the screen with red color and a coded 

note.   

5.2.8 Generate Structural Drawings 

The program provides you with the option to generate structural drawings     

with detailed reinforcement and post-tensioning (when applicable) 

information for construction.  These tools are described in greater detail in 

Chapter 10 of the ADAPT-Floor Pro 20 Basic Manual.  The information 

contained in this reference applies equally to ADAPT-MAT and ADAPT-

Floor Pro as part of the ADAPT-Builder platform.   

o For an expeditious outcome of your design, use the “rebar 

generation” tool to view rebar along design strips in the X and 

Y directions.  The program will show required, enveloped 

reinforcing for the top and bottom of the slab and/or beams.   

o Review the generated reinforcing and edit the size, orientation, 

number and length of the bars, if needed. 

o Add any reinforcement that you consider necessary to complete 

the detailing of the structure.   

o View/modify the font size and line properties of the drawing 

suitable for the size of drawing file (.DWG) that will be 

exported to a CAD format.   

o Export the drawing to AUTOCAD for production. 

5.2.9 Generate Structural Calculation Reports 

Refer to Chapter 11 of the ADAPT-Floor Pro 20 Basic Manual.  This 

document contains a detailed explanation of Reports that can be produced 
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by both ADAPT-MAT and ADAPT-Floor Pro along with a sample report.  

Using this as a guide or reference, prepare a similar report for your 

project. 

FLOW CHART FOR DESIGN OF MAT (RAFT) FOUNDATION 
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6.1 OVERVIEW 

This tutorial package is tailored to the needs of design engineers who are seeking 

to become familiar with the latest developments in design of reinforced concrete 

MAT /RAFT (foundation slab consisting of extended layers of concrete and usual 

resting on soft ground) systems. The tutorial covers, in detail, the process of 

designing reinforced concrete (RC) MAT foundation using the ADAPT-Builder 

suite of software with focus on ADAPT-MAT. Long regarded as a difficult 

engineering challenge, designing concrete floor systems is greatly simplified with 

ADAPT-Builder, which provides significant efficiencies throughout the design 

process.  This tutorial is broken into several sessions, which would likely to take 

four hours in total.  

This tutorial uses the following programs of the ADAPT-Builder Design Suite: 

• ADAPT-Modeler® 20 

• ADAPT-MAT® 20 

6.2 INTRODUCTION 

This tutorial walks you through the complete modeling, analysis, design and 

detailing of a reinforced concrete mat/raft system. It covers the procedure to 

import a 2D drawing file and transform it to the required model. During the 

loading procedure we will use efficient options available inside ADAPT Builder 

environment.  

The tutorial concludes with the construction drawing showing general 

arrangements, structural calculation reports and the non-pre-stressed 

reinforcement.  Along the way, the tutorial will cover more advanced modeling 

and analysis topics within ADAPT-Builder. 

The tutorial is broken down into several sessions, each intended to guide you 

through a specific aspect of design.  The material that follows is intended for a 

user that has some basic familiarity with ADAPT-Builder.  The step-by-step 

procedures outlined in each section do not contain all intermediate steps. 

The raft/mat system selected for the tutorial is specifically developed, to 

demonstrate salient steps of RC MAT foundation design using ADAPT Builder 

Environment. Its overall dimensions are approximately 164 x 90 feet.  The project 

data for this tutorial has been generated in US units.  
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This tutorial is based on AC318-2014 (including provisions from IBC 2015). Note 

that the bulk of material presented in this tutorial applies to many building codes 

included in the software, such as EC2, IS, Australian, Canadian and BS8110.  

Items such as allowable stresses, load combinations and associated factors will 

change depending on the code you wish to use for future designs.   

6.3 DESIGN SCOPE AND CRITERIA 

6.3.1 Structural Layout 

This outlines the criteria to be used for the structural engineering design of 

a typical mat system (Fig. 6.3-1) of the subject matter project. 

 

FIGURE 6.3-1 TYPICAL REINFORCE CONCRETE MAT SYSTEM 

The concrete outline and the general structural plan with key dimensions 

are shown below: 
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FIGURE 6.3-2 GENERAL STRUCTURAL PLAN (US) 

6.3.2 Material Properties  

Concrete: 

Weight     = 150 pcf 

Cylinder Strength (f’c) at 28 days = 4000 psi (slab);  

   5000 psi (column & wall) 

Creep Coefficient   = 2 

Non-pre-stressed Reinforcement: 

Yield Strength    = 60 ksi 

Modulus of Elasticity   = 30,000 ksi 

Soil: 

Allowable Long-Term Pressure = 2000 psf 

6.3.3 Applicable Codes 

 

The design is based on ACI318-14/IBC 2014.  
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6.3.4 Structural Documents 

 

The final design should include following:  

 

o Structural Calculation  

o General Arrangement Drawings 

o Loading Plans 

o Design Section Report 

o Rebar required and provided at all locations 

o Design Section Capacity 

6.3.5 Design Loads 

6.3.5.1 Dead Load 

Self-weight    = based on volume 

Superimposed Dead Load  = 0.04 ksf on the entire raft  

Line Load along the walls  = 1.37 kip/ft along edge walls  

     = 1.7 kip/ft along other walls  

Point Load (Column Reactions) = 56.2 kip downward axial   

load  

     = 18 kip along major axis  

     = 9 kip along minor axis  

6.3.5.2 Live Load 

Uniformly Distributed  = 0.21 ksf 

No lateral loading and any other loadings are not considered in 

this    tutorial model. However, one may refer to the other tutorial 

for further clarification.  

6.3.6 Load Combinations and Stresses  

The parts and factors of the program’s automatically generated load cases 

and load combinations are listed below. All combinations follow ACI 318 

and IBC 2015 stipulations. 
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6.3.6.1 Strength Load Combinations 

The strength requirement for each member is established using 

the following factored load combinations: 

Only for Dead Load: 

U = 1.40 x Selfweight + 1.40 x Dead load  

For Dead and Live Load: 

U = 1.20 x Selfweight + 1.20 x Dead load + 1.60 x Live load 

6.3.6.2 Serviceability Load Combinations 

Load Combinations for Serviceability Check: 

Sustained in-service load combination (stress check) 

U = 1.00 x Selfweight + 1.00 x Dead load + 0.30 x Live load  

Total in-service load combination (stress check) 

U = 1.00 x Selfweight + 1.00 x Dead load + 1.00 x Live load  

6.3.6.3 Initial Load Combinations 

Load Combinations for Initial staged check: 

U = 1.00 x Selfweight 

6.3.7 Deflections 

The deflections will be calculated for both uncracked (gross moment of 

inertia) and cracked (effective moment of inertia).  Long-term deflections 

are estimated using a creep coefficient of 2. 

For the mat foundation the maximum deflections are maintained below the 

following values with the understanding that the structure is not attached 

to nonstructural elements likely to be damaged by large deflections of the 

slab: 

Maximum allowable total long-term deflection = L/240 
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Maximum allowable live load deflection = L/360 

Where, L = length of clear span. 

Hence, Load combination for long-term deflection due to creep and the 

instantaneous action of live load: 

U = 3.00 X Dead load + 1.00 x Live load  

Load combination for checking deflection under live load: 

U = 1.00 Live Load 

6.3.8 Cover 

Mild Reinforcement clear covers for the Raft are given below: 

Cover to top bars  = 1.25 inch 

Cover to bottom bars  = 1.50 inch 

6.3.9 Soil Properties 

Let us take an example of the structural modeling of foundations that rest 

on multiple soil layers and each have a different spring constant (Winkler 

constant).  

Figure 6.3-3 shows a foundation slab on three layers of soil, each with its 

own spring constant k1, k2 and k3. The stiffness experienced by the 

foundation slab at its interface with soil (interface A in the figure) is due to 

the combined responses of the three underlain soil layers 1, 2 and 3. 

User needs to determine the equivalent spring constant that must be 

specified for the determination of slab deflection and its design. For 

academia let us also determine the force and displacement at the interface 

of each of the layers.  
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FIGURE 6.3-3 SLAB ON MULTI LAYER SOIL FOUNDATION 

6.3.9.1 Equivalent Spring Constant 

The equivalent spring constant for design of the foundation is the 

sum of the inverse of the spring constants of each of the underlain 

soil layers. For the condition shown in Figure 6.3-3, the constant 

to be used for the analysis of the foundation ke is given by: 

1/ke = (1/k1 + 1/k2 + 1/k3) 

6.3.9.2 Soil Pressure 

The displacement of the foundation at its interface with the soil 

(interface A in Figure 6.3-3) is determined through the analysis 

of the foundation using ke. For displacement “d” at any given 

point, the soil pressure “p” is: 

p = ke * d 

The soil pressure “p” remains the same for the underlain layers. It     

will be the same for layers A, B and C shown in the figure. 

6.3.9.3 Displacement at Interface of Soil Layers 

At interface A, the vertical displacement is equal to the value 

determined from the analysis of the foundation slab, namely “d.” 

The reduction (r) in thickness of layer 1 is: 

r1 = p/k1 

Hence, the vertical displacement of interface B will be:  
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dB = d – rA 

Using a similar procedure, the displacement of the interface 

between other layers can be determined. 

6.3.9.4 Numerical Example  

Given: 

A foundation slab is supported on the following: 

• First layer: 4” synthetic material with spring constant 

200 pci 

• Second layer: 24” soil with spring constant 250 pci 

• Third layer: 7 ft of native soil with spring constant 300 

pci 

Required: 

• Determine the equivalent soil constant for the analysis 

of the foundation 

• If the vertical displacement of the foundation at a point 

is obtained to be 0.138 inch, determine the force in each 

of the layers and the vertical displacement at the 

interface of each. 

Solution: 

The equivalent soil constant for the analysis of the foundation is: 

1/ke = (1/k1 + 1/k2 + 1/k3) 

= (1/200+ 1/250 + 1/300) = 1/81.08 

ke = 81.08 pci  

For a vertical displacement of 0.138 inch, the soil pressure is: 

 

P = ke * d = 81.08 * 0.138 = 11.19 psi (1611 psf) 

Using Winkler foundation, the pressure on all the underlain layers 

will be the same. 

Vertical displacement at interface of soil layers: 

 

Displacement at layer A, dA = 0.138 inch  
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Compression in thickness of first layer: 

r1 = p/k1 = 11.19/200 = 0.056 inch 

 

Displacement at layer B, dB = dA – r1  = 0.138 – 0.056 = 

0.082 inch 

Compression in thickness of second layer: 

r2 = p/k2 = 11.19/250 = 0.04476 inch 

 

Displacement at layer C, dC = dB – r2 = 0.82 – 0.0447 = 

0.0373 inch 

Compression in thickness of third layer: 

r3 = p/k3 = 11.19/300 = 0.0373 inch 

 

Displacement at layer D, dD = dC – r3 = 0.0373 – 0.0373 = 

0.00 inch 

No displacement value at interface D agrees with the assumptions 

of the example. 

6.4 GENERATION OF 3D STRUCTURAL MODEL THROUGH DWG 

IMPORT 

The steps to follow for the generation of a 3D structural model of the floor system    

through import of a drawing file are detailed below.  After the initial drawing has 

been transformed into a structural model, the steps to import a revised drawing are 

outlined.  The descriptions of each step are general and should be applied to any 

model used as an example or tutorial.  

6.4.1 First Drawing Import 

At this step, the simplified structural or architectural drawing will be 

imported to the Builder program and converted to a structural model. 

Follow the steps below: 

o Open the Builder program in MAT mode with American unit 

system (as shown in Fig. 4.2-1). 

o From the File ribbon select File | Import | DXF/DWG 

o Open the desired .dwg file 
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o Now Project Calibration Dialog (Figure 6.4-1) will appear. 

Select Calibrate imported objects to enter calibration mode.  

The cursor will default to Snap mode. 

o Before you click, make sure the Snap to End button is selected 

from the Snap Tools at the Lower Quick Access Bar.  

 

FIGURE 6.4-1 PROJECT CALIBRATION DIALOG 

 

o Calibrate the drawing using any of the dimension lines shown 

in the drawing or a known distance between two points.  The 

User Message Bar (UMB) will ask to “Enter the Start Point 

of Calibration Line.”  This is the bar below the selected 

modeling ribbon.  

 

o Click on the first known point.  The UMB will ask to “Enter 

the End Point of Calibration Line.”  Click on the second 

known point. Now it will ask to “Enter the Correct distance 

in feet between the two Points you Selected.”  Input the 

proper dimension in feet and hit enter. This will complete 

calibration of the drawing.  

o For this tutorial, click “No” when asked if you want to change 

the project origin. 
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FIGURE 6.4-2 START AND END POINTS OF CALIBRATION LINE 

6.4.2 Transformation of Structural Components  

 

o Open the Transform tools located on the Build ribbon for 

conversion of the drawing to structural model.  

 

FIGURE 6.4-3 TRANSFORM TOOLS 

 

o Use ribbon item Home | Display | Layer Settings, to open the 

Layers dialog box. Click on the button All Layers Off. This 

will turn off all the layers in the drawing.  Click on the light 

bulb icon in the On/Off column for the layer representing the 

structural columns (Figure 6-4-4) to turn on only the objects in 

this layer while the display of other objects remain turned off. 
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FIGURE 6.4-4 LAYERS DIALOG BOX 

 

o Now only the polygons drawn in selected layer will be 

displayed in the screen. Select all of them using Ctrl+A. Once 

the column polygons are selected use the Transform Column 

icon from the Transform tools.   

IMPORTANT:  Only polygons can be transformed using the 

transformation toolbar in ADAPT-Builder.  If your drawing 

file contains components that are composed of individual lines, 

this tool will not work.   

o Change the view to an Isometric View by selecting Top-

Front-Right View from Home | Camera/Zoom. You will 

notice all polygons are changed to a Column entity in the 

drawing; you may double click on any column to change or 

view its General Properties, Location, FEM Properties and 

CAD properties (as shown in Figure 6.4-5). Notice that when 

in ADAPT-MAT mode all columns will be resting on slab, i.e. 

modeled as Upper Column and placed under 

Current_Plane_Column layer.  
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FIGURE 6.4-5 TOP-FRONT-RIGHT VIEW WITH TRANSFORMED COLUMN AND 

COLUMN DIALOG 

 

o Select the menu item Home | Display | Layer Settings, to 

open Layers dialog box. Click on the button “All Layers Off”. 

And this time turn All Layers Off and turn on that layer 

representing the structural slab layer (Figure 6.4-4) to display 

only the polygon representing the slab region(s). 

o Select the polygon(s) and use Transform Slab Region icon 

from the Transform tools to convert the polygon to a slab. The 

slab will be placed as the Current_plane_Slab_Region layer. 

o Finally open the Layer dialog once again. This time turn All 

Layers Off while turning on only the layer representing any 

walls.  

o Select all the polygons (representing walls) and use the 

Transform Wall icon from the Transform tools to convert all 

polygons as walls. Walls will be placed in the 

Current_plane_Slab_Region layer. All walls will be Upper 

Walls and will be placed under the Current_plane_Wall 

layer. 

o Now use the View Settings icon  from the Visibility 

ribbon. 

o This will open the Select/Set View Items dialog box. By 

default, the Structural Components tab will be open. Turn on 

the display of Slab Region, Column and Wall as shown in 

Figure 6.4-6 and click on “OK.” This will display all 

structural objects in the screen. 
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FIGURE 6.4-6 SELECT/ SET VIEW ITEMS DIALOG BOX 

 

o Now save the file. This file contains the structural model 

created from the drawing file using the ADAPT-MAT 

environment.  

6.5 MATERIAL, SOIL SUPPORT, CRITERIA AND LOADINGS 

Open the previously saved file if you have closed it. If you have completed all of 

the steps successfully as specified in the earlier section, you may continue with 

the file you created and saved in your hard disk.  

6.5.1 Set and Assign Material Properties 

 

6.5.1.1 Set and Assign Multiple Concrete Materials  

Since we need to specify two grades of Concrete (one for the slab, 

another for columns and walls), use the menu item Concrete | 

Material Properties | Concrete. The material dialog box for 

Concrete will open. By default, there will be one concrete already 

established. Click on the Add button to add another concrete.  
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FIGURE 6.5-1 CONCRETE MATERIAL DIALOG BOX 

Now select Concrete 1 and rename the label as Concrete Slab. 

Specify Weight (Wc) 150 pcf and 28 days Cylinder Strength 

(f’c) as 4000 psi. The Modulus of Elasticity of concrete is 

automatically calculated and displayed by the program using f’c 

and Wce, and the relationship as mentioned in section 8.5.1 of 

ACI 318-08 is given below. The user is given the option to 

override the code value and specify a user defined substitute. The 

user can specify Wce in place of Wc which will be used only to 

calculate Ec value.  

   Ec = Wc1.5 X 33 f 'c    US 

   Ec = Wc1.5 X 0.043 f 'c    SI 

 

   Where, 

   Ec = modulus of elasticity at 28 days [psi, MPa] 

   f’c = characteristic cylinder strength at 28 days 

   Wc = density of concrete [150 lb/ft3, 2400 kg/m3] 

Similarly, select Concrete 2 and rename the label as Concrete 

CW. Specify Weight 150 pcf and 28 days Cylinder Strength as 

5000 psi.  
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Now click on the Select by Type  tool from the Home ribbon. 

Refer to Chapter 4 for additional details. Select Column and 

Wall and click on OK. This will select all columns and walls in 

the model. Now use the ribbon item Modify | Properties | 

Modify Selection, to open the Modify Item Properties dialog 

box. Turn on Material (located in top left corner), select 

Concrete CW from the drop-down list (Figure 6.5-2). Click on 

OK, to apply this concrete for all selected entities, i.e. columns 

and walls. 

To change the material for the slab region you can use same 

procedure to specify the Concrete Slab material. Alternately, 

double click on the slab. The Slab Region dialog box will open. 

Select the drop down for Material and ensure Concrete Slab is 

specified as material (Figure 6.5-3). 

 

FIGURE 6.5-2 MODIFY ITEM PROPERTIES DIALOG BOX 
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FIGURE 6.5-3 SLAB REGION DIALOG BOX 

6.5.1.2 Set and Assign Mild Steel Material (Rebar) 

Use the ribbon item Criteria | Materia Properties | Rebar to 

open the Material dialog for Mild Steel. Specify the value of fy 

as 60 ksi and the value of Es as 29000 ksi. Click “OK.”  Since 

this is single entry, this property will be applied for all 

components.  

6.5.2 Assign Soil Support 

There are two choices to model soil support. One may snap the corner 

points of the slab to model the soil support. Otherwise as we want to 

model soil support of uniform stiffness for the entire foundation, we can 

model a rectangular or quadrilateral soil support which inscribes the entire 

foundation. Both will give same result considering soil support below the 

foundation slab area only. For this tutorial, the second option will be used.   

 

FIGURE 6.5-4 SOIL SUPPORT TOOLS 

Use ribbon item Model | Springs. The UMB will ask to specify four 

corners.  Click on four corners surrounding the slab region and press C to 

Close/End/Accept. Ensure that the soil spring boundary inscribes the mat 

area (Figure 6.5-5).  
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FIGURE 6.5-5 SOIL SUPPORT INSCRIBING THE MAT FOUNDATION 

Now double click on the Soil Support to open its property box (Fig. 6.5-

6). As computed in Section 6.3.9.4, specify kza value 81.08 pci. Retain 

the spring type as Compression Only.  

 

FIGURE 6.5-6 SOIL SUPPORT PROPERTY BOX 
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6.5.3 Set Criteria 

Let us now set design criteria for this project. This should be done before 

we enter in loadings as automatic load combinations are generated based 

on the design code selected by the user.  

Use the Criteria ribbon to open the dialog box. Go to the Design Code 

panel  and select ACI 2014/IBC 2015 for this project (Figure 6.5-7). 

Please note that some of the codes will be unavailable for selection as they 

do not support the US unit system. 

 

FIGURE 6.5-7 DESIGN CODE CRITERIA 

It is recommended to click on all the criteria panels and ensure that the 

desired parameters are set.  Specific to this tutorial, go to Rebar 

Size/Material  to specify preferred rebar diameters for the top bar as 

#5 and for the bottom bar as #6. 

6.5.4 Input and Assign Loadings 

ADAPT-MAT will automatically consider Self-Weight as we specified 

Wc for the concrete materials. The program also has two reserve load 

cases as Dead Load and Live Load. In this tutorial, we need to specify 

area loads, line loads and point loads from Loading | General.  

6.5.4.1 Patch Load Generation 

Select the slab and click on the Patch Load Wizard  tool  

from the Loading | General panel. Specify a value of 0.04 ksf as 

Superimposed Dead Load. The program will display a 

confirmation dialog specifying one patch load is applied. This 
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will apply 0.04 ksf uniformly distributed loading on the entire 

foundation slab. 

 

FIGURE 6.5-8 AUTOMATIC PATCH LOAD WIZARD 

Again, select the slab and click on the Patch Load Wizard tool 

to specify 0.20 ksf as Live Load.  

6.5.4.2 Line Load Generation  

Select all the boundary walls located in the model, if any. You 

may select all walls by using the Select by Type tool and then 

hold down the Ctrl key to de-select any internal walls. Click on 

the Line Load Wizard icon from Loading | General to assign 

1.37 k/ft line loading along the boundary walls under the Dead 

Load condition. The program should confirm the number of line 

loads generated. 

Now select only the internal walls and similarly specify 2.0 k/ft 

line   loading for walls other than the boundary walls.  

 

FIGURE 6.5-9 AUTOMATIC LINE LOAD WIZARD 

 

6.5.4.3 Point Load Generation 

To apply point loads as column end reactions, use the Add Point 

Load tool. Ensure that the Snap to Endpoint tool is activated 

which will allow you to snap to the column centerline(s). Click on 

one of the columns which will add a point load without any value. 

Double click on the point load to open the Point Load dialog box 

(Figure 6.5-10).  Input Fz = 56.2 kip inside the General tab and 
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go to Loads tab to input Fx = 18 kip and Fy = 9 kip. Finally click 

on the green checkmark to assign the load values. Once done 

program will remember these values for further generation(s).   

   

FIGURE 6.5-10 POINT LOAD DIALOG BOX (GENERAL AND LOADS TABS) 

Click on the Add Point Load tool again and ensure that the Snap 

to Endpoint tool is activated.  Snap on all other columns to apply 

this loading. Where column reactions are different from each 

other, the user needs to edit its property and change the values 

accordingly.  

6.5.4.4 Load Combinations 

Based on the code selected by the user, ADAPT-MAT 

automatically generates Initial, Strength and Service conditions. 

The user can add or modify any number of load combinations. 

However, please note that the program obtains a discrete solution 

for each load combination; hence, additional load combinations 

will result in prolonged processing time.  

Furthermore, for a structure like this which is supported by a 

series of “Compression Only” springs with some finite stiffness, 

superposition of load cases doesn’t apply. As an example, the 

deflection for the dead load and live load cases when calculated 

individually, may not add up to the deflection calculated for the 

combined actions.  

Use the menu item Loading | Load Cases/Combo | Load 

Combination . The program will contain following load 

combinations: 
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Service (Total Load) = 1.00 x Selfweight + 1.00 x Dead 

load + 1.00 x Live load  

 

Service (Sustained Load) = 1.00 x Selfweight + 1.00 x 

Dead load + 0.30 x Live load  

 

Strength (Dead and Live) = 1.20 x Selfweight + 1.20 x 

Dead load + 1.60 x Live load 

 

Strength (Dead Load Only) = 1.40 x Selfweight + 1.40 x 

Dead load  

You need to create the following combinations for checking 

deflection due to Live Load only and Long-Term Deflection. 

Specify NO CODE CHECK under Analysis/Design Options as 

you don’t need to check stress and calculate rebar requirement for 

these conditions.  

 

LongTerm= 3.00 x Selfweight + 3.00 x Dead load + 1.00 x 

Live load  

 

LiveLoad = 1.00 x Live Load 

 

FIGURE 6.5-11 LOAD COMBINATION DIALOG BOX 

Now save the file. This file contains the structural model, 

materials, soil support, design code, rebar specification and 

loadings with load combinations. 
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6.6 FINITE ELEMENT MESHING, ANALYSIS AND VIEW RESULTS 

Open the previously saved file if you have closed it. If you have completed all 

steps successfully as specified in the earlier sections, you may continue with the 

file you created and saved in your hard disk.  

The model is now ready for analysis. ADAPT-MAT supports the Object-Oriented 

Modeling approach which allows users to model the physical components as they 

are truly represented. Once done, the program can automatically generate a finite 

element mesh.  From Analysis | Meshing | Mesh Generation, the user can 

specify a sparse or uniform mesh.  The default is set to a sparse mesh as it will 

lead to a faster processing time without compromise or a degraded solution.  The 

user can also specify the suggested cell size and node consolidation parameters. It 

is recommended to review Chapter 8 of the ADAPT-Floor Pro 20 Basic Manual 

for a thorough description of meshing features in ADAPT-Builder as they are also 

applicable to ADAPT-MAT.   

6.6.1 Finite Element Meshing 

The menu item Analysis | Meshing | Mesh Generation will be used for 

creation of the first mesh. In this tutorial the suggested cell size of 3 ft will 

be used.  Turn on the Shift nodes automatically option if it is not already 

set and specify maximum distance as 1.5 ft. 

 

FIGURE 6.6-1 AUTOMATIC MESH GENERATION DIALOG 

Click on OK to generate finite element mesh as shown below.  
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FIGURE 6.6-2 FINITE ELEMENT MESH  

6.6.2 Analyze Structure 

Use the menu item Analysis | Analysis | Execute Analysis and confirm in 

the subsequent dialog box (Figure 6.6.3), that the model is ready for 

analysis. For this model with soil spring supports, the program will 

produce iterative solutions for each load combination. Click on Yes to 

save the solution and terminate this dialog. 

 

FIGURE 6.6-3 ANALYSIS STATUS DIALOG 

6.6.3 View Results 

Once the analysis has been successfully completed select Analysis | 

Analysis | View Results.  
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FIGURE 6.6-4 ANALYSIS PANEL  

This will open the ADViewer (View Results) screen. From the left-hand 

panel of the screen select the tab Load Case/ Combinations.  

6.6.3.1 View Deflection 

o Select Service (Total Load) from the list of the load cases 

o On the top of the same left-hand panel, click on Results 

o From the list of results, select Deformation > Z-translation. 

This will display the vertical deflection of the structure. 

o Click on the button Display Results  icon. This will 

display the color contour for displacement as shown in Figure 

6.6-5.   

o Use the Warping  and Rotate  tools on the 

screen to examine the deflected shape of the model. 

 

FIGURE 6.6-5 DISPLAY SCREEN OF FEM SOLUTIONS 
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6.6.3.2 Review of Soil Pressure 

• Select Soil Pressure under the Results tab. This will display 

soil pressure for the selected Load Combination. Use the tab 

Load Case/ Combinations from left-hand panel to scroll 

through all combinations specified in the model. The soil 

pressure is reported as ksi. 

 

FIGURE 6.6-6 SOIL PRESSURE UNDER RESULT TAB 

 

Important Note: The allowable soil pressure does not apply to 

the pressure reported at a “point” in a contour plot, such as in 

Figure 6.6-7. The allowable soil pressure is intended for the 

average pressure over a minimum area, such as a square or 

circle having a diameter or side value between three to four times 

of the slab thickness. In the design check of this tutorial, if the 

point pressure is within the allowable value, the design is 

considered acceptable. Otherwise, using the pressure contour, the 

average pressure over the preceding minimum area would have 

had to be calculated and checked with the allowable value. 
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FIGURE 6.6-7 SOIL PRESSURE FOR STRENGTH CONDITION  

 

• The user may also view other actions like Bending Moment of 

the slab about the X or Y global axes for different conditions. 

This gives an indication of the regions with maximum 

moments in a particular direction and possible line of 

cracking/ failure for the concrete slab. This might be used as a 

guideline to define support line for design.  

• Close the ADViewer screen by using menu item File | Exit or 

the red X at the top-right corner. This will close the results 

viewer and return to the main screen of ADAPT-MAT.  

6.7 GENERATION OF SUPPORT LINES AND USE OF SPLITTERS 

Open the previously saved file if you have closed it. If you have completed all 

steps successfully as specified in earlier section, you may continue with the file 

you created and saved in your hard disk.   

The model is now ready to be designed. The first step is to create Support Lines in 

both X and Y directions.  These are required to establish design strips (i.e. 

tributary regions) for the generation of design sections.  In some cases, the use of 

splitters is required to generate a more refined tributary region.  Splitters are used 

when support lines do not terminate at slab or opening boundaries. Once support 

lines and splitters are created, the program can successfully generate design 

tributaries and automatically create design sections.  Design sections are required 
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to check the adequacy of the slab as it relates to the selected code for Strength and 

Serviceability requirements.  Punching Shear (two-way shear) will also be 

checked for the slab. Finally, we will review the results and produce a results 

report.   

6.7.1 Generation of Support Lines 

 

• Support lines in the X-direction will be drawn first. Use the Create X-

Support Line  tool from Floor Design | Strip Modeling. Click on 

the Item’s Properties  icon of the Bottom Quick Access toolbar. 

A dialog box, as shown in Figure 6.7-1, will be displayed. Make sure 

the intended direction of the Support Line is set to X-Direction. Click 

the green check mark to accept the modification if not. Click the X to 

close the window. 

 

FIGURE 6.7-1 SUPPORT LINE DYNAMIC EDITOR 

 

• Click on the slab edge where the wall end point ends at the slab edge 

at the top of the model. Move your mouse over to the next support in 

you line of supports. Keep clicking at supports until you get to the end 

slab boundary. Make sure to click at the centroid of columns, end 

points of walls and beams, centerline of transverse walls and beams. 

This is done to define the span lengths along the support line. Click the 

final vertex for the support line at the opposite slab edge, from where 

you started the support line, and click C to close the modeling of that 

support line.  

 

• Repeat the operation to create other support lines in the X-direction. 

After closing the support line modeling using the C key on your 

keyboard you may start modeling your next support line. Once you 

have finished modeling the support lines you can press ESC on your 

keyboard to exit out of the support line modeling tool. Once you have 
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finished entering support lines in the example model your model 

should look as shown in Figure 6.7-2 

 

FIGURE 6.7-2 SUPPORT LINES IN X-DIRECTION 

 

• Using the approach described above for the X-direction, draw support 

lines in Y-direction. Figure 6.7-3 shows the layout of the Y-direction 

support lines once they have been entered in the model.   

 

FIGURE 6.7-3 SUPPORT LINES AND SPLITTERS IN Y-DIRECTION 
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• Save the file. This file contains the structural model, materials, soil 

support, design code; rebar specification, loadings with load 

combinations, finite element mesh, analysis result, support lines and 

splitters. 

6.7.2 Use of Splitters 

The use of splitters changed in ADAPT-Builder 2019. The use of splitters 

has been simplified to creating a boundary that the tributary edge extends 

when the width is required to be limited to either side. Splitters are no 

longer required for any other purpose as the program has been improved to 

recognize support line nodes at any location and properly generate strips. 

Therefore, the use of splitter is no longer necessary in the bounds of this 

tutorial. For more information on the new use of splitters please refer to 

the ADAPT-Builder 2019 New Features Supplement Manual. You can 

find this manual by going to Help→Documentation in the main user 

interface. 

6.8 PRODUCE AND REVIEW DESIGN RESULTS  

Open the previously saved file if you have closed it. If you have completed all 

steps successfully as specified in earlier section, you may continue with the file 

you created and saved in your hard disk.  This model is ready to proceed for 

design. 

6.8.1 Review Analysis/ Design Options 

Since the model was opened under the RC-only mode (Conventionally 

reinforced only), the user would have to generate column strips and 

middle strips to remain compliant with ACI design protocols.  In ADAPT-

Builder 2019, due to improvements in support line generation tools, the 

program no longer generated middle strips automatically. In ADAPT-

Builder 20 we have reintroduced the automatic middle strips option in a 

different manner than previously implemented in the software. For more 

information on the new middle strip modeling tools refer to the ADAPT-

Builder 20 New Features Supplement Manual. Go to Criteria | Design 

Criteria | Analysis/Design Options to open the dialog box shown in 

Figure 6.8-1.  
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FIGURE 6.8-1 ANALYSIS/DESIGN OPTIONS FOR RC DESIGN 

 

• Ensure that the option is selected as Yes from the Conventionally 

reinforced only (RC) option. The option of minimum rebar refers to 

the code required reinforcement for creep, shrinkage, and temperature. 

If this item is not selected, the program reports the reinforcement 

needed to satisfy those requirements for the strength limit state of the 

structure only.  

6.8.2 Generate Design Sections  

 

After entering the column strips in the model go to Floor Design | Strip 

Modeling | Dynamic Editor to open the dynamic editor window shown in 

Figure 6.8-2.  
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FIGURE 6.8-2 SUPPORT LINE DYNAMIC EDITOR WIZARD TAB 

 

Click on the Middle Strip tab to show the middle strip options. Click on 

the Create Middle Strips button. The program will show middle strips that 

it will generate in blue as shown in Figure 6.8-3. 

 

FIGURE 6.8-3 VIEW OF AUTOMATICALLY GENERATED MIDDLE STRIPS 
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Click the close button to accept and create the middle strips. To generate 

design sections at each of the support lines, use the menu item Floor 

Design | Section Design | Generate Sections New .  

6.8.3 Review Design Strips (Column and Middle Strips) 

 

• Use Floor Design | Strip Results/Visibility | Display/Hide X- or Y- 

Tributaries to view the generated column strips and middle strips in 

either direction as shown in Figure 6.8-4.  Middle and column strips 

are shown hatched in Figure 6.8-5 for this example.   

  

FIGURE 6.8-4 DESIGN STRIPS IN X- AND Y- DIRECTION  

 

FIGURE 6.8-5 COLUMN AND MIDDLE STRIPS IN X-DIRECTION 
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FIGURE 6.8-5 COLUMN AND MIDDLE STRIPS IN Y-DIRECTION 

6.8.4 Design the Design Sections 

Use Floor Design | Section Design | Design the Design Sections  to 

process and produce design section actions and results.  

Once the design has been successfully completed, the program will 

display a confirmation dialogue box as shown in Figure 6.8-6. Click on 

Yes to save the results and close this message. 

 

FIGURE 6.8-6 DESIGN STATUS DIALOG BOX 

6.8.5 Adequacy Check for the Design Sections 

 

• Now click on Yes to save the result and dismiss the Design Status 

dialog box. 
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• Go to Floor Design | Strip Results/Visibility | Display Design 

Sections . To view results for either design strip direction, utilize 

the X and Y direction strip display tools on the same tool panel.   

 

• Click each of them to view support lines and design sections, once for 

the X-direction and once for the Y-direction.  

 

• Make a cursory review of the support line results in both directions.  

Where design sections are shown in a green color, the sections are 

found adequate for the specific design check selected from the Results 

Browser by clicking on the Results display Settings  icon. Any 

section shown as a dashed pink line has not met the required code 

checks and is inadequate.  Typically, in RC design, for strength checks 

design sections will be shown as OK for design status (green color) as 

the program will design the required amount of reinforcement to 

satisfy the demand actions.   

 

• For serviceability it is important to make a check for deflections in 

each direction.  Select Service (Total Load) from the Loads tab of the 

Results Browser as shown in Figure 6.8-7.  Change to the Display tab 

of the Results Browser. Set the Maximum Span/Deflection Ratio. L/ 

value 240. Change to the Analysis tab of the Results Browser. Expand 

the Design Sections→Deformation tree and select Z-Translation.  

 

• From Floor Design | Strip Results/Visibility | Display Graphically, 

turn on the support lines in either direction, the program will report the 

deflection ratio (X/L) for each span as shown in Figure 6.8-8.  Note 

also that the deflection value for each design section is shown.  The 

same display of results can be produced for any action (i.e. moment, 

shear, axial) when the result to be displayed is set for an Action and 

the Display Graphically tool is active.  

 

Note: When the program is opened in RC and PT mode, additional 

results will become active in the Results Browser dialogue box.  The 

program will give the option to report top and bottom fiber stresses for 

any service combination as well as average precompression. 
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FIGURE 6.8-7 RESULT DISPLAY SETTINGS DIALOGUE BOX 

 

FIGURE 6.8-8 DEFLECTION RESULTS ALONG SUPPORT LINE 

 

FIGURE 6.8-9 SUPPORT LINES AND DESIGN SECTIONS RESULTS IN X-

DIRECTION 
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FIGURE 6.8-10 SUPPORT LINES AND DESIGN SECTIONS RESULTS IN Y-

DIRECTION 

 

• Figures 6.8-9 and 6.8-10 shows support line example results for the 

graphical code check.  

6.8.6 Generate Rebar Drawing 

 

• Once the design of sections is complete, use the menu item Floor 

Design | Rebar | Calculated Rebar Plan  to display the rebar 

required to meet demand for serviceability, strength or envelope. The 

dialog box as shown in Figure 6.8-11 will be displayed.  

 

• The user can select the any of the load combinations defined in the 

model to view rebar for.  Note that when the ACI318 code is selected, 

no rebar will be generated for serviceability conditions as the code 

waives temperature and shrinkage reinforcement for soil supported 

slabs. You may choose the Bar Length Selection and the Bar 

Orientation, and then click OK. If the orientation of the bars is Along 

support lines the reinforcing is aligned parallel to the support lines 

even if they are not in the X-Y directions. The selection of an angle 

generates rebar layouts for those directions. The Dynamic Rebar 

Module calculates the required reinforcement for the direction 

selected. For this tutorial, specify Library Length and to have 

desirable rebar length and bar orientation along global X and Y axis as 

shown in Figure 6.8-11.  
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FIGURE 6.8-11 GENERATE REBAR DRAWING OPTIONS 

 

• The program will display the requirement of rebar at the top and 

bottom faces of the slab and/or beams at all positions for the enveloped 

condition (considering strength requirement and minimum rebar for 

service condition when required per code) as shown in Figure 6.8-12. 

 

FIGURE 6.8-12 INITIAL REBAR ARRANGEMENT 

 

• Use Rebar | Visibility | Display Manager  to display/ hide rebar 

object in different layers and different directions.  

6.8.7 Specify Base Reinforcement and Re-design 

 

• It is often impractical and uneconomical to provide a design or rebar 

layout showing different sizes and spacing of rebar at different 
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positions for construction. In review of the initial rebar layout for this 

tutorial model, it is important to consolidate size and spacing for 

groups of bars and determine a uniform rebar mesh, both the top and 

bottom layers, that will satisfy the initial requirement.  Once this is 

done, the slab can be redesigned.   

 

• Select the slab and click on the Mesh Reinforcement Wizard  tool 

from Rebar | Base.   

 

• A dialog box as shown in Figure 6.8-13 will be displayed. Specify the 

layer of reinforcement you are going to define as Bottom and use the 

Bar size option. For this example, specify #6 @ 10 in c/c in both the 

directions. Click on the Create button to add this rebar as user defined 

base reinforcement.  Not that if you are using a different slab for the 

tutorial, determine what spacing and size of reinforcement is required 

as mesh rebar to satisfy the initial reinforcement output from the 

program.   

 

FIGURE 6.8-13 AUTOMATIC MESH REINFORCEMENT DIALOG 

 

• Similarly, add #5 @ 9 in c/c as Top base reinforcement or what is 

required for the model you are using for this tutorial.   

  

• After introducing new base reinforcing, the slab needs the design 

sections to be redesigned and the reinforcement layout must be 

generated again. The program will produce a new rebar drawing and 

display any additional rebar to the base reinforcing where required as 

shown in Figure 6.8-14. 
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FIGURE 6.8-14 REBAR IN EXCESS OF BASE REBAR 

6.8.8 Punching Shear Check 

Before we perform a punching shear check we need to set the punching 

shear settings to be used at each column. These settings are accessible 

through the new Properties Grid. Select the columns in the model and 

expand the punching shear section of the Properties Grid to reveal the 

settings that can be set. Figure 6.8.15 shows the Punching Shear section 

of the Property Grid for wall and column components. For more details on 

these options refer to the ADAPT-Builder 20 New Features Supplement 

Manual. 

 

FIGURE 6.8.15 PROPERTIES GRID PUNCHING SHEAR OPTIONS 
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• Specify the stud diameter as 0.375 in (#3); shear reinforcement type is 

stud and number of rails per side is 2. The user can modify this per 

column or select all columns to modify all columns at once. 

• Use the menu item Floor Design | Punching Shear | Execute 

Punching Shear  to perform a check of punching (two-way) shear 

for this slab. The program will show the following dialog when done. 

 

FIGURE 6.8-16 PUNCHING SHEAR CHECK COMPLETION DIALOG 

 

• Use Analysis | Analysis | Results Display Settings   to view the 

results on screen. In the Loads tab of the Results Browser select Load 

Combos | Envelope | Strength Envelope. In the Analysis tab of the 

Results Browser select Punching Shear | Stress Ratio to view the 

stress ratios for either local axis (‘r’ or ‘s’) direction. There are 4 cases 

the program can report for design status. They are as follows: 

 

o “OK” – calculated stresses are below allowable stresses 

o “Reinforce”- calculated stresses exceed allowable stresses and 

design code requires reinforcement 

o “Exceeds Code” – design code requirements are not satisfied 

o “NA”- punching shear design is not applicable 

 

• In addition, the program will report the controlling load combination 

and controlling section in the design. 

• The punching shear results for this model are shown in Figure 6.8-17. 
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FIGURE 6.8-17 PUNCHING SHEAR DESIGN OUTCOME 

 

• Further information related to punching shear including design 

parameters, actions, actual stress from shear and moments and 

allowable stress are included in the tabular output. The following is a 

description of how to generate this output. 

 

• From the menu select Reports | Single Default Reports | Punching 

Shear.  

 

• The user has the following options:  

  

o Punching Shear Stress Check Result 

o Punching Shear Stress Check Parameters, and  

o Punching Shear Reinforcement 

 

• An example of each is given in Figures 6.8-18 to 6.8-20.  

• In addition, there is an excel spreadsheet that has more detailed 

punching shear results that can be accessed by selecting Reports | 

Single Default Reports | Punching Shear | Punching Shear Results. 
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FIGURE 6.8-18 PUNCHING SHEAR STRESS CHECK RESULTS 

 

FIGURE 6.8-19 PUNCHING SHEAR STRESS CHECK PARAMETERS 

In this example since the stress ratio for all columns are less than 1, shear 

reinforcement is not required.  To obtain a solution which requires shear 

reinforcement, in order to display shear reinforcement output, the Strength 
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combination load factors were increased.  The results from this design are 

shown in Figure 6.8-20.    

 

FIGURE 6.8-20 PUNCHING SHEAR REINFORCEMENT 
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This section provides information on several aspects of the analysis and design features 

of ADAPT-MAT. 

7.1 OVERVIEW 

ADAPT-MAT is a standalone computer program within the umbrella of the 

ADAPT-Builder software platform. It has been entirely developed by ADAPT’s 

team of structural engineers and software developers in providing a complete 

analysis and design solution for mat and raft foundations.  The program is the 

most comprehensive three-dimensional (3D) finite element (FEM) analysis and 

design tool for conventionally reinforced or post-tensioned mat foundations, with 

or without grade beams.  Using ADAPT's intuitive and easy-to-use Component 

Technology, it is the only solution available that also calculates the required 

reinforcement at all locations of the foundation automatically.  

Using ADAPT-MAT, you can quickly generate a graphical model of a ground 

supported slab mat with or without grade beams. The model can be generated 

using either an available DWG or DXF file of the foundation, or through user 

input. The mat can be of any irregular shape and subject to any kind of loading 

from above. Using an adaptive meshing and finite elements, the program analyzes 

the mat and determines the location, amount, and length of all the reinforcement 

needed by computation. Where applicable, under horizontal loading or moments, 

the program accounts for the separation of a mat from the soil. 

7.2 STRUCTURAL MODELING 

7.2.1 Analysis 

The analysis processor of ADAPT-MAT is based on the finite element 

formulation developed and implemented in the ADAPT-Builder platform, 

with some modifications to cover the features that are specific to mat 

foundation analysis. The program uses almost entirely well-proportioned 

quadrilateral flat shell elements with bending and membrane degrees of 

freedom. Details of the formulation are given in the ADAPT-Floor Pro 

20 Basic Manual and its references. Walls are also represented by the 

same type of shell elements. 

Beams and columns are modeled as beam (stick) elements with six 

degrees of freedom at each node. 
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Unlike many other commercially available programs, complete 

compatibility of displacement is established over the entire foundation 

system and among all its components. For example, grade beams below 

the foundations are modeled eccentric to the slab = as they appear in real 

life = but are solved with full compatibility of displacement at their 

interface with the slab (equal strains in beam stem and slab at a common 

interface). 

Post-tensioned tendons, where present, are discretized into segments 

associated with each shell element they traverse. When force calculation is 

invoked by you, the force along each tendon varies as passes from one 

shell element into the next. 

The advanced and unique features of ADAPT-MAT have become possible 

due to a finite element formulation specifically developed for analysis of 

complex concrete structures, including post-tensioning [Aalami, 2003]. 

7.2.2 Design 

The design involves (i) the calculation of “design values” (demand), (ii) 

the comparison with allowable limits of the building code selected by the 

user, and (iii) provisions of reinforcement, where applicable. 

The design values are determined in a manner like an elevated slab and are 

dependent on the generation of design sections associated with design 

strips (tributary regions) evolving from support lines. The procedure for 

creation of support lines and design sections is explained in detail in the 

ADAPT-Floor Pro 20 Basic Manual. The important point to note is that 

for each design section the builder platform determines the design values 

from the equilibrium of the finite element nodes, as opposed to the 

common practice of using the integration of stresses along a cut at the 

section. As a result, accurate design values are obtained for a relatively 

coarse finite element mesh [see ADAPT Technical Note TN302, 

“Evaluation of Design Values at Design Sections Using ADAPT-

Builder Platform”]. 

7.3 MISCELLANEOUS TOPICS  

7.3.1 Soil Pressure 

In addition to the values reported for slabs (stresses, moments, etc.), as in 

ADAPT-Floor Pro, the program also reports the distribution of soil 
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pressure below a slab as indicated in Figure 7.3-1. The following in the 

interpretation and evaluation of soil pressure is noteworthy. 

 

FIGURE 7.3-1 EXAMPLE OF THE DISTRIBUTION OF SOIL PRESSURE BELOW A 

MAT WITH FULL SOIL/MAT INTERFACE CONTACT 

The raw data obtained from a finite element analysis, as shown in the 

figure above, is the distribution of stress at “points” below the foundation 

slab. From a practical point of view, however a high or low value of soil 

pressure at a “point” does not reflect the likely response of the soil that is 

of interest to design engineer.  For an engineering evaluation, when 

dealing with a reinforced concrete slab resting freely on soil, one considers 

the average pressure over a minimum area of design significance.  For 

concrete slabs resting on common soil1 a minimum diameter four to five 

times the slab thickness should be considered. In other words, at the 

location of design check, the distribution of soil stress reported below the 

slab, should be integrated over a “design” significant area to determine the 

total force. The total force over the “design” patch when divided over the 

area of the patch will yield the design stress to be compared with the 

allowable soil pressure for the soil. 

 

 
1 Bulk modulus 100 to 200 pci 
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7.3.2 Superposition 

In the general case, the principle of superposition of solutions obtained for 

different load cases does not apply to mat foundation slabs.  Each solution 

obtained for a load combination is unique since a different set of boundary 

conditions applies to each.  Even though the solutions obtained for the mat 

foundations are based on elastic material properties, the different amount 

of separation of soil from the mat between any two load cases creates a 

difference between the structural systems that carries the load in each of 

the two load cases. Once the structural systems changes, superposition 

does not apply. 

 


	Chapter 1
	Chapter 2
	2.1 Overview
	2.2 Geometry
	2.3 Support conditions
	2.3.1 Soil Support Area
	2.3.2 Compression Only Soil
	2.3.3 Soil / Rock Anchors
	2.3.4 Grade Beam Support
	2.3.5 Line Springs
	2.3.6 Point Springs
	2.3.7 Point Supports
	2.3.8 Line Supports
	2.3.9 Piles
	2.3.10 Voids in Soil

	2.4 Material properties
	2.5 Loads
	2.5.1 Load Cases
	2.5.2 Load Combinations

	2.6 Base Reinforcement
	2.7 Post-Tensioning
	2.8 Analysis
	2.9 Design
	2.10 Generation of Drawings
	2.11 Link With 3rd party programs and ADAPT Data Exchange

	Chapter 3
	3.1 Overview
	3.2 Opening the Program
	3.3 Quick Start – step-by-step
	3.3.1 Create a Grid
	3.3.2 Building the Model
	3.3.3 Viewing the Model
	3.3.4 Defining the Soil Support
	3.3.5 Application of Loads
	3.3.6 Mesh and Analyze
	3.3.7 Viewing Analysis Results


	Chapter 4
	4.1 Overview of ADAPT-Builder Platform
	4.2 ADAPT-Builder Splash Screen
	4.3 ADAPT-Builder graphical user interface
	4.3.1 Mouse Function and Operation
	4.3.2 Main User Interface


	Chapter 5
	5.1 Overview
	5.2 Design procedure
	5.2.1 Create the Structural Model
	5.2.2 Define Soil Support Conditions
	5.2.3 Validate the Structural Model
	5.2.4 Complete and Finalize Input Data
	5.2.5 Perform Analysis
	5.2.6 Prepare to Design
	5.2.7 Validate the Code Compliance of the Design
	5.2.8 Generate Structural Drawings
	5.2.9 Generate Structural Calculation Reports


	Chapter 6
	6.1 Overview
	6.2 Introduction
	6.3 Design Scope and criteria
	6.3.1 Structural Layout
	6.3.2 Material Properties
	6.3.3 Applicable Codes
	6.3.4 Structural Documents
	6.3.5 Design Loads
	6.3.5.1 Dead Load
	6.3.5.2 Live Load

	6.3.6 Load Combinations and Stresses
	6.3.6.1 Strength Load Combinations
	6.3.6.2 Serviceability Load Combinations
	6.3.6.3 Initial Load Combinations

	6.3.7 Deflections
	6.3.8 Cover
	6.3.9 Soil Properties
	6.3.9.1 Equivalent Spring Constant
	6.3.9.2 Soil Pressure
	6.3.9.3 Displacement at Interface of Soil Layers
	6.3.9.4 Numerical Example


	6.4 Generation of 3D Structural Model through DWG Import
	6.4.1 First Drawing Import
	6.4.2 Transformation of Structural Components

	6.5 Material, Soil SupporT, Criteria and Loadings
	6.5.1 Set and Assign Material Properties
	6.5.1.1 Set and Assign Multiple Concrete Materials
	6.5.1.2 Set and Assign Mild Steel Material (Rebar)

	6.5.2 Assign Soil Support
	6.5.3 Set Criteria
	6.5.4 Input and Assign Loadings
	6.5.4.1 Patch Load Generation
	6.5.4.2 Line Load Generation
	6.5.4.3 Point Load Generation
	6.5.4.4 Load Combinations


	6.6 Finite Element Meshing, Analysis and View Results
	6.6.1 Finite Element Meshing
	6.6.2 Analyze Structure
	6.6.3 View Results
	6.6.3.1 View Deflection
	6.6.3.2 Review of Soil Pressure


	6.7 Generation of Support Lines and Use of Splitters
	6.7.1 Generation of Support Lines
	6.7.2 Use of Splitters

	6.8 Produce and Review Design Results
	6.8.1 Review Analysis/ Design Options
	6.8.2 Generate Design Sections
	6.8.3 Review Design Strips (Column and Middle Strips)
	6.8.4 Design the Design Sections
	6.8.5 Adequacy Check for the Design Sections
	6.8.6 Generate Rebar Drawing
	6.8.7 Specify Base Reinforcement and Re-design
	6.8.8 Punching Shear Check


	Chapter 7
	7.1 Overview
	7.2 Structural Modeling
	7.2.1 Analysis
	7.2.2 Design

	7.3 Miscellaneous Topics
	7.3.1 Soil Pressure
	7.3.2 Superposition



